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Chapter 1 : Tutorial: SQL Server Management Studio (SSMS) | Microsoft Docs
To complete this tutorial, you need SQL Server Management Studio and access to a SQL Server instance. Install SQL
Server Management Studio. If you don't have access to a SQL Server instance, select your platform from the following
links.

Instructions for restoring databases in SSMS are here: The following examples show how to do so when you
back up a database and when you shrink the transaction log. Expand the Databases node. Configure the
backup the way you want. For this tutorial, everything is left at default. However, any changes made in the
window also reflect in the script. Review the T-SQL populated in the query window. Select Log from the File
type drop-down list box: Select Script and Script Action to Clipboard: Open a New Query window and paste.
Right-click in the window. Select Execute to execute the query and shrink the transaction log. Script databases
The following section teaches you to script out the database by using the Script As and Generate Scripts
options. The Script As option re-creates the database and its configuration options. You can script both the
schema and the data by using the Generate Scripts option. In this section, you create two new databases. You
use the Script As option to create AdventureWorksa. You use the Generate Scripts option to create
AdventureWorksb. Review the database creation query in the window: This option scripts out only the
database configuration options. Select the down arrow to open the Replace option. Select Execute to execute
the query and create your new AdventureWorksa database. The Introduction page opens. Select Next to open
the Chose Objects page. You can select the entire database or specific objects in the database. Select Script
entire database and all database objects. Select Next to open the Set Scripting Options page. Here you can
configure where to save the script and some additional advanced options. Select Save to new query window.
Select Advanced and make sure these options are set: Script Statistics set to Script Statistics. Types of data to
script set to Schema only. Script Indexes set to True. Note You can script the data for the database when you
select Schema and data for the Types of data to script option. It can take more memory than SSMS can
allocate. This limitation is okay for small databases. If you want to move data for a larger database, use the
Import and Export Wizard. Select OK, and then select Next. Select Next on the Summary. Then select Next
again to generate the script in a New Query window. On the top Find line, enter AdventureWorks On the
bottom Replace line, enter AdventureWorksb. Select Execute to execute the query and create your new
AdventureWorksb database. Script tables This section covers how to script out tables from your database. Use
this option to either create the table or drop and create the table. You can also use this option to script the
T-SQL associated with modifying the table. An example is to insert into it or update to it. In this section, you
drop a table and then re-create it. Expand your Databases node. Expand your AdventureWorks database node.
Expand your Tables node. Select Execute to execute the query. This action drops the Errorlog table and
re-creates it. Note The Errorlog table is empty by default in the AdventureWorks database. However,
following these steps on a table with data causes data loss. Expand your Programmability node. Expand your
Stored Procedure node. Right-click the stored procedure dbo. Script extended events This section covers how
to script out extended events. Expand your Management node. Expand your Extended Events node. Expand
your Sessions node. Right-click Sessions in Object Explorer. Select Refresh to see your new extended event
session. The green icon next to the session indicates the session is running. The red icon indicates the session
is stopped. Note You can start the session by right-clicking it and selecting Start. You can delete the copy of
the extended event session: Go to the next article to learn more:
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Chapter 2 : MS SQL Server Management Studio
The SQL Server Management Studio (SSMS) tutorial introduces you to the integrated environment for managing your
SQL Server infrastructure. SQL Server Management Studio presents a graphical interface for configuring, monitoring,
and administering instances of SQL Server.

SQL Server Management Studio components This section describes the various window components that are
available in the workspace, and how to use them. To close a window, select the X in the right corner of the
title bar. To reopen a window, select the window in the View menu. Object Explorer is a tree view of all the
database objects in a server. Object Explorer includes information for all servers that are connected to it. The
results of your queries also appear here. You can see the Properties view when the Query Window is open.
The view displays basic properties of the query. For example, it shows the time that a query started, the
number of rows returned, and connection details. You can use these templates to perform various functions,
such as creating or backing up a database. Object Explorer Details F7: This view is more granular than the
view in Object Explorer. You can use Object Explorer Details to manipulate multiple objects at the same time.
For example, in this window, you can select multiple databases, and then either delete them or script them out
simultaneously. Change the environment layout This section describes how to change the environment layout,
such as how to move various windows. To move a window, press and hold the title, and then drag the window.
To pin or unpin a window, select the pushpin icon in the title bar: Each window component has a drop-down
menu that you can use to manipulate the window in various ways: When two or more query windows are
open, the windows can be tabbed vertically or horizontally so that both query windows are visible. To view
tabbed windows, right-click the title of the query, and then select the tabbed option that you want: To restore
the default environment layout, in the Window menu, select Reset Window Layout: Click anywhere in the
Query Editor window. This keyboard shortcut works with any document window. Change startup options
Startup options determine what your workspace looks like when you first open SSMS. Reset settings to the
default You can export and import all these settings from the menu.
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Chapter 3 : Tutorial: Using templates in SQL Server Management Studio | Microsoft Docs
Microsoft SQL Server Management Studio Express (SSMSE) is an integrated environment for accessing, configuring,
managing, administering, and developing all components of SQL Server. SQL Server Management Studio Express
combines a broad group of graphical tools with a number of rich script editors to provide access to SQL Server to.

In this section, you learn how to locate and use Template Browser. You can see recently used templates at the
bottom of the template browser. Right-click the template, and then select Open: You can also double-click the
template name to open it. A new query window opens. The T-SQL script is already populated. Modify the
template to suit your needs, and then select Execute to run the query: Edit an existing template You can also
edit existing templates in Template Browser. In Template Browser, go to the template you want to work with.
Right-click the template, and then select Edit: In the query window that opens, make the changes that you
want to make. Close the query window. Your edits should appear. Locate templates on disk When a template
is open, you can locate the templates that are on disk. In Template Browser, select a template, and then select
Edit. The explorer should open where the templates are stored on disk: Create a new template You can also
create a new template in Template Browser. The following steps show you how to create a new folder, and
then create a new template in that folder. You can also use these steps to create a custom template in an
existing folder. Name this folder Custom Templates: Enter a name for your template: Right-click the template
you created, and then select Edit. The New Query Window opens. Enter the T-SQL text that you want to save.
In the File menu, select Save. Close the existing query window, and then open your new custom template.
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Chapter 4 : Download SQL Server Management Studio
Tutorial: Using templates in SQL Server Management Studio. 03/13/; 2 minutes to read Contributors. In this article. This
tutorial introduces you to the prebuilt Transact-SQL (T-SQL) templates that are available in SQL Server Management
Studio (SSMS).

In the Connect to Server window, do the following: For Server type, select Database Engine usually the
default option. For Authentication, select Windows Authentication. If you select SQL Login, you will be
prompted for a username and password. For more information about authentication types, see Connect to
server database engine. You can also modify additional connection options by selecting Options. This article
uses the default values for all the options. Examples of successful connections To verify that your SQL Server
connection succeeded, expand and explore the objects within Object Explorer. Create a database Create a
database named TutorialDB by doing the following: Right-click your server instance in Object Explorer, and
then select New Query: Into the query window, paste the following T-SQL code snippet: After the query is
complete, the new TutorialDB database appears in the list of databases in Object Explorer. Create a table in
the new database In this section, you create a table in the newly created TutorialDB database. Because the
query editor is still in the context of the master database, switch the connection context to the TutorialDB
database by doing the following: In the database drop-down list, select the database that you want, as shown
here: Paste the following T-SQL code snippet into the query window, select it, and then select Execute or
select F5 on your keyboard. You can either replace the existing text in the query window or append it to the
end. To execute everything in the query window, select Execute. To execute a portion of the text, highlight
that portion, and then select Execute. Insert rows into the new table Insert some rows into the Customers table
that you created previously. To query the Customers table and view the rows that were previously inserted, do
the following: Customers; The results of the query are displayed under the area where text was entered:
Modify the way results are presented by selecting one of the following options: The middle button displays the
results in Grid View, which is the default option. The first button displays the results in Text View, as shown
in the image in the next section. The third button lets you save the results to a file whose extension is. Verify
your connection properties by using the query window table You can find information about the connection
properties under the results of your query. After you run the previously mentioned query in the preceding step,
review the connection properties at the bottom of the query window. You can also view the query duration and
the number of rows that are returned by the previously executed query. In the image, note that the results are
displayed in Text View. Change the server that the query window is connected to You can change the server
that your current query window is connected to by doing the following: The Connect to Server window opens
again. Change the server that your query is connected to. Note This action changes only the server that the
query window is connected to, not the server that Object Explorer is connected to. Go to the next article to
learn more:
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Chapter 5 : MSSQL TU Database-Construction Using Microsoft SQL Server Management Studio Express
To script any object in Object Explorer, right-click it and select the Script Object As option. This tutorial shows you the
process. Prerequisites. To complete this tutorial, you need SQL Server Management Studio, access to a server that's
running SQL Server, and an AdventureWorks database.

This is not the actual server but it provides an opportunity to connect and work with SQL elegantly. In this
article we will cover most of available options in this tool. This will help you to connect with four different
Server Types Database Engine: To work with relational databases. Here, we use the Transact SQL queries to
communicate with server. You have to select the Authentication that you want to use for connecting to server.
If you are the system admin, and if your SQL Server is installed in the local computer then you can use this
option. In real-time we always have to use this mode of authentication. This will ask the user to enter
Username, and Password to connect with server. If we want to write a Query against any database then you
have to click New Query button as we shown below. It is Tree view structure that will display all the database
Objects in a Server. Holds the databases that are available in the server. It contains all Security related things.
Use this folder to Create Logins , Server Roles etc. This folder contains information about Subscriptions, and
publications. Use this folder for maintenance such as Checking Server Logs, Session health etc. This folder is
used to create Maintenance Plans Query Window: To write a query against any database. Use this to save the
current query window in file system. This drop down list will display all the databases that are available in this
server. You can select the database that you want to work with. This will open a New Query window along
with Connect to database Engine window. First, you have to connect with Database Engine and then you can
use the query window to write your own query. This button will cut the selected text. This button will copy the
selected text. Use this button to paste the Cut, or Copied content Undo: Use this button to undo the changes
Redo: This button is used to redo the changes in query window Navigate Backward: Please click this button to
see the activity monitor. It contains the information about the process, Resources, data Files etc. Use this
button to debug your code. Use this to find your files. To find required text in a query window Solution
Explorer: By clicking this button, Toolbox will be added to the left side As we said before, if you click on the
New project button following window will be opened. Use this to replace anything. The Solution Explorer will
show you the Files information. And the Properties Window will show all the information about the query
such as Connection, Query execution time, Duration, returned rows etc. Used to connect to Server Change
Connection: You can change the existing connection by clicking this button Available Databases: It executes
the query inside the query window and return the result in result pane. It will help you to debut your code. It
will stop the running query. It will help you to stop the long running query. Use this to check whether then
Query is parsed or not. Display Estimated Execution Plan: This will help you to find the syntax errors, and it
will auto suggest the function names. Include Actual Execution Plan: This will help you understand the
execution Include Client Statistics: Enabling this option will include the Client Statistics Execution type,
Bytes sent and received etc along with query result. This will help you understand the execution Result to
Text: Result will display as text. Result will be displayed in table format or grid format. This is the default one
Result to File: Use this option to save the query result in text file. Comment out the Selected Line: Click this
button to comment the current line. Click this button to uncomment the current line or selected line. Used to
decrease the distance Increase Indent: Use this to increase the distance. Use Decrease Indent, and Increase
Indent to properly organize the code. Following screenshot will show you the list of available option in this
menu. SSMS can show you the report for each and every object that you select. By clicking the Cube you can
see the Analysis Server, clicking report button will show the reporting Server, and last button is to display the
Integration Server. By clicking on individual item you can see their definitions. For now, we will explore the
Optionsâ€¦ sub-menu so, let me select the same By clicking the options.. Use this window to change the
default color, Fonts type, Size, weight, Keyboard shortcuts etc. I suggest you to explore all the option, but

Page 5

DOWNLOAD PDF MICROSOFT SQL SERVER MANAGEMENT STUDIO 2008
TUTORIAL
remember to note down the changes you made. If anything wrong happens then this will help you to recover
easily. Or, use Restore Defaults button on each page to restore the settings to default settings. You can alter
the default destination of Query result Result to Text: Use this page to change the table option SQL Server
Management Studio â€” Windows Menu If you are new you might have accidentally positioned some of
windows panes in wrong position.
Chapter 6 : Tutorial: SQL Server Management Studio components and configuration | Microsoft Docs
Tutorial: SQL Server Management Studio components and configuration. 03/16/; 3 minutes to read Contributors. In this
article. This tutorial describes the various window components in SQL Server Management Studio (SSMS), and some
basic configuration options for your workspace.

Chapter 7 : Download SQL Server Management Studio (SSMS) | Microsoft Docs
Once SQL server has been installed successfully start it up by going to Start > All Programs > Microsoft SQL Server R2
> SQL Server Management Studio. You should see a screen similar.

Chapter 8 : Tutorial: Script objects in SQL Server Management Studio | Microsoft Docs
SQL Server Express with Management Tools is an easy-to-use version of the SQL ServerÂ® Express data platform that
includes the graphical management tool SQL Server Management Studio (SMSS) Express To read what is new in SQL
ServerÂ® R2 click here.

Chapter 9 : What is Microsoft SQL Server Management Studio (SSMS)
Added new services in SQL Management Studio for SQL Server: Check Database, Indices Management, Shrink
Database and Update Statistics. There was an issue concerning installation on disks having more than 2Tb of free
space.

Page 6

